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Installation 
 
 
The Hatchery Maestro - Advisor Network Program does not require a formal installation. 
If you purchased the network computer system from Chick Master the files will already be 
installed to a folder on your desktop.  The network system will be referred to as the 
Maestro system.  The Advisor system is identical to the Maestro system except for the 
features Setpoints, Stage Programming, and Stage Control, which are only available on 
the Maestro system.  
 
Inside the folder you will view files: A “maestro.exe”, “oracle.exe”, or “CMHN.exe” and 
redundant back up “cmhn.lic”.   
 
The redundant backup is known as “Acronis”.  Your files will be backed up to the second 
hard drive every Sunday at 12:00 A.M. unless programmed differently. 
 
The maestro.exe file is the application file. 
 
The cmhn.lic is the license file, be sure to back this file up to a safe location! 
 
After running the application for the first time you will notice a new file will be created in 
the same folder titled, “ *.dta “. This file contains all the archived data collected by the 
Hatchery Maestro program.  The “*.dta” files are saved under c:  users\customer name:. 
 
Each time you create or delete a room or machine the database will reinitialize the data 
file. If you’ve accumulated a substantial amount of data and you wish to add a new 
machine it would be recommended to backup the “*.dta” file to a secure location prior to 
adding the machine to the Maestro application. 
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Maestro Back-Up  

 
 
If you have not included validation into the backup task settings, it is strongly 
recommended to validate the backup later – by performing the validation task either 
manually or on schedule. You should get into the habit of validating your backups. 
 
 
For Chickmaster purposes, follow the instructions below for Backup and Recovery: 
 1. Double click Acronis True Image Home 2012. 
 2. Click Backup. 
 3. Double click Disk and Partition Backup. 
 4. Make sure C is displayed. 
 5. Destination should be H:\mybackups (H should be your second hard drive). 
 6. Turn the schedule option on for it to copy your data on a schedule.   
 7. Backup scheme: Incremental. 
 8. Backup name: you can change this to something that lets you know you are   
     copying to the C drive or leave H drive as my partitions. Then click Backup Now.   
  
Follow the instructions below for Additional Backup and Recovery 
 1. Double click Acronis True Image Home 2012. 
 2. Click File Backup. 
 3. Click on cmaestro (this is to backup all cmaestro files). 
 4. Destination should be H:\mybackups (H should be your second hard drive). 
 5. Turn the schedule option on for it to copy your data on a schedule.   
 6. Backup scheme: Incremental. 
 7. Backup name: create a new name or leave it as mybackup. Then click Backup    
     Now.   
 
 
 

Disclaimer  

 
 

The Maestro notification system relies on a good internet connection.  
 
If the internet connection is lost, the system will be unable to notify via text 
messages and e-mails. 
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Maestro Tab Overview  

 

Please read through the instructions and use in conjunction when building your hatchery. 
 
When opening Maestro, there will be four tabs in the top tool bar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The “File” tab menu will display 
as follows: 
 

The “About” tab menu will 
display as follows: 
 

The “Hatchery” tab menu will 
display as follows: 
 

The “View” tab menu will display  
as follows: 
 

View Maps    page 16 
View Utilities   page 17 
View Charts   page 18 
View Alarm Log  page 20 
View Calendar   page 21 
View Alarm Screen page 22 
View Setpoints   page 24 
          (View and edit machine setpoints.)   
View Stage Program page 25 
          (View and edit stage programs.)  
View Stage Control page 32 
          (Shut/Stop or change stage.) 
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Pass Code Setup 

 
Once installed and running, you will be presented with a blank canvas which you will use 
to build your hatchery. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will need a pass code to proceed.  Pass code “1881” allows you to create a unique 
user pass code, which must be done immediately, otherwise the user will not be allowed 
access to create or make any changes. 
 
At the top of the screen to the left is a toolbar with the words, File, Hatchery, View and 
About.   Click on “Hatchery” which displays a drop down list.  Scroll down to “New 
Passcode”.  This will open your screen to the “New Passcode” screen.  Enter 1881 in the 
Pass code window. Enter your new pass code, four or more text and/or numbers, and 
then re-enter new pass code to confirm new code.  Press “OK”. 
 
 
 
 
 
 
 
 
 
 
 
Under “Hatchery”, in the drop down list click on “Edit Mode”. This will bring up the  
following “Edit mode log in” screen.  Type in your newly created pass code and press 
“OK”. 

1881 

***** 

***** 
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Exporting 

 
 
 
 
Under the File tab are three drop down export options.   
 
1.  The “Export Machine Data” exports as a “tda” formatted 
file to the designated Export Directory location as set up 
by the operator.   
 
 
 

 
Settings, items, auto export frequency, and export directory can all be located as shown 
on the screen shot below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  The “Export Alarm Log” exports as a “dta” formatted file to the designated machine 
export directory. 
 
3.  The “Export Hatchery Layout” exports the hatcher main layout as a “dta” formatted 
file, which makes it easy to move the layout to another computer.   
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Hatchery Layout Setup 
 
 
 
While in the editing mode, the screen will 
display as a graph. 
 
 

 
 
 
 
 
 
Right click on the grid part of 
the screen and left click on 
the text icon “New Room” 
that will appear next to the 
arrow cursor which will 
change to a “+” shape.   
 

 
 
Click/hold and drag the mouse to create a 
square/rectangular room displayed as a solid gray shape. 
This will be the first room of your hatchery.  
 
 

 
Once created, a “Room Properties” 
screen will pop up requesting a 
name for the room.  Type in your 
selected name and press ok.  The 
name of the room will appear in the 
upper left corner of the shaded area.   
 
 
You can add as many rooms as 
necessary, be sure not to overlap 
rooms though. If this occurs, simply 
click and hold the room and move it 
to the desired location. 
 
Likewise if you make a room too big 
or too small you can move the 
mouse to the lower right-hand 
corner of the room shape to resize. 
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Hatchery Layout Setup (continued) 
 
After naming the room, you may enter the 
room one of two ways.  Place the cursor on 
the shaded area and click to create hatched 
marks around the designated room.  You 
may double click to enter the hatched mark 
area or you may place your cursor on the 
“ + ”  magnifying glass icon in the tool bar 
at the top of the screen. 
 
 
 
 
 
 
To exit a room you may click on the  
1) “house” icon which takes you back  
to the drawing board or you  
may click on the 2) “    ”  minus  
magnifying glass icon which moves   
you back one pane at a time.    
If you attempt to “X” out of the room,  
you will be asked if you want to close  
the program. 

 
 
 
Upon entering the room, you may right click 
your mouse and a text box displays as shown 
to the left.    
 
You may choose one or none of the options. 

 
If you choose “Properties”, it will allow you to 
edit the name of the room. 
 
 
 
 
 
 
 

You may place the cursor on the room name  
hold/drag to any area on the shaded area.  You 
may also increase or decrease the text by placing 
cursor in lower right corner which will change  
the cursor to directional arrows and allows adjusting size of name. 

Click on “ + ”  magnifying glass  
                   or 
double click on hatched mark 
shaded area to enter room. 

1 2 
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Incubator Properties Set Up    
 
Upon entering a created room the controller can 
right click to choose one of the options.  One of the 
options is “New Incubator”.  When choosing the 
“New Incubator” move your cursor to the arrow to 
the right to display a drop down list of control 
machine options.  Move down the list and click on  
the correct control option.  
 
 

 
The cursor will change to the “+”.  
Hold and drag to place the incubator 
within the room. The following 
Incubator Properties screen will 
appear requesting the information as 
indicated on the illustration to the left. 
Enter name and other incubator 
features requested depending on the 
chosen control system. 
 
 
 
 

 
Note the “Com Port” 
also has a drop 
down list to 
accommodate 
multiple com ports. 
 
If machines need to 
be worked on or out 
of service, it will be 
necessary to click 
“Off Line”.  When 

machines are “Off 
Line”, they will be 
shaded dark gray 
and alarms will not 
be activated for 
these specific rooms. 
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Double Click 

Incubator Properties Set Up   (continued) 
 

                                                                                                                                                                                                                
 
After an incubator is named 
and values are added, it will 
look similar as illustrated to 
the left. 
 
The controller can double 
click on the incubator room 
and the following screen will 
appear as shown below 
displaying individual 
monitors for each variable 
of the chosen control, in 
this case Genesis IV.  These 
monitors will be explained 
in more detail later in this 
manual. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
To back out of this screen and return to the main layout, click on the “    ” minus 
magnifying glass icon. 
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Zone ID Set Up    
 
The Zone ID can also be described as ‘Node ID’ and/or ‘Network Address’.  The only time 
multiple Zone ID boxes will be necessary will be for machines with Gemeric, Gem O, or  
Gem controls.  In all other type of machines, only one Zone ID is used.   
The use of multiple Zone ID’s will be set by the user according to the number of zones 
that a machine has.  There needs to be a Zone ID for each zone and for the humidity.  All 
other machines will use only one Zone or Node ID.  For the network to be linked properly 
the correct COM port will need to be selected.   
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View of Room Controller 

range of temperature and 

humidity. 

View of Room Controller upon exiting from 

entering values.  Double click on room above to 

view the screen to the left displaying range. 

1.) “Room Controller Properties” 

values need to be entered. 

 

Room Controls Properties Set Up 
 
By right clicking within a room the drop down list 
will provide “New Room Controller”.  Move the 
cursor to the arrow to the right to display the drop 
down list of the type of room control options. Drop 
down and click on the correct room control.   
 

 
 
 
 
 
 
 
 
 
 

The cursor will 
change to the “+”.  Hold and drag to place 
the controller within the room. The 
following screen will appear requesting 
the information/values as indicated in the 
illustration to the right and will differ 
depending on chosen room control. 
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New Alarm Center Properties Set Up 

 
Only one alarm will be placed within the hatchery.  The placement of the alarm is an 
individual decision but is usually centrally located and easily accessible.  

 
 
By right clicking within a room the drop down 
list will provide “New Alarm Center”.  The 
cursor will change to the “+”.  Hold and drag to 
place the alarm center within the room.  
 
 
 
 

 
The following screen will appear displaying 
 “Dialer Properties”.  Complete the Com Port  
and the Comm ID. 
 
Next click on the the “Alarm Center” tab on 
the lower left hand corner. 
 

 
This brings up the Alarm Center 
Properties screen as shown to the left. 
 
The list of notifications need to be 
checked for horn, light, dialer, and 
*contacts (*see contacts next page for 
details). 
 
 
 
 
                                                                                                                                                      
 

 
 
 
 
 
 
 
Disabled notifications need to be set for the 
days of the week and times when the alarms 
should not be enabled. This will disable the 
dialer and selected contacts only the local horn 
and light will continue to function normally. 
 

Near the bottom 
left side is the 
window with a 
drop down list 
to set the timer 
delay before the 
notifications 
enable the 
alarm. 
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Double click on 
the “Alarm Center” 
To bring up the 
Alarm Center 
Comm screen. 

New Alarm Center Properties Set Up (continued) 

 
 
 
 
 
Under the Disabled notifications, is a  
button to click on “Contacts” . 
 
 
 
    
 

This brings up the 
“Contacts” screen.  Phone 
numbers, service providers, 
names, and email addresses 
of individuals who will be 
notified for specific alarms.  
At this point the controller 
checks who needs to be 
notified when alarms are 
enabled. 
In addition to the alarms, 
individuals can be notified 
for maintenance, set, transfer, 
hatch, and miscellaneous 
tasks.  
 

 

 

In addition to going through the “Alarm Center” 
to edit contacts and/or alarm center notifications, 
you may also go to the “Hatchery” in the top tool 
bar to the drop down list and scroll down to 
“Contacts” or “Alarm Center Properties”.
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Chiller Properties Set Up 

 
If a chiller is part of the hatchery, a new room can be 
created and once created the controller can right 
click to choose the “New Chiller” option.   
 
The cursor will 
change to the “+”.  
Hold and drag to 
place the chiller 
within the area. 
The following 
Chiller Properties 
screen will appear 
requesting the 

information as indicated on the illustration to the right.  
Enter name and other chiller features requested and 

relevant to the 
hatchery. 
 
 
  
Once the chiller room is created, the controller can 
double click on the chiller room to display the warm 
temperature coming into the chiller and the cool 
temperature leaving the chiller.  Pressure is also 
displayed.  If the wavy line between the warm and 
cool temperature is malfunctioning a flow switch 
alarm will activate. 

 
Overview 
 
Once completed, your hatchery will appear something like this and can be viewed in this 
view any time by clicking on the 
“Map” icon.  Note:  View below is 
in “non-edit” format. 
 
In this section, we will cover the 
basics of how you can use The 
CMaestro to better monitor your 
hatchery status. 
 
From the main screen you will be 
able to view each room in the 
hatchery. 
 
The rooms equipped with Room Control Systems, as you can see, will report and log 
room temperature and humidity trends. 
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– White = OK 
– Red = Alarming 
– Dark Gray = Off Line 
– Blue = Communication Loss 

 

Blue = Communication Loss 

Red = Alarming 

Overview continued 
 
The machine colors indicate the machine 
 condition. 

      
 

      
Control Type:  Gen IV Controls 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

Hatcher/Setter 
Indicator Actual Set Point 

High Alarm SP 

Current Reading 

Low Alarm SP 

Outputs Mode 
Turning 
Alarms 

Turn Count 
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Global Hatchery Status Indicator and Map View 
 
 
 
 
 
 
 
 
 
 
 
 
     
    ALARM, the indicator is Red. 
 
 
 
 
 
 
 
 
 
   

The Global Hatchery Status Indicator will be displayed as a green geodesic globe or an 
alarm enclosed in a red geodesic globe. Found on the toolbar, this allows the user to 
monitor the status of the entire hatchery from any screen. 
 
                                            NO ALARM, the indicator is Green.                       
                

Red rooms indicate “alarm”. 

While in the “map” icon mode, there will be a layout of the hatchery 
in a miniature version next to the “Global Hatchery Status Indicator”.   
Green rooms = Success  (No Alarm) 
Red rooms = Failure  (Alarm) 
Yellow rooms = Out of Service  
Blue rooms = Communication Loss 
 Map Icon 

Green rooms indicate “no alarm”. 

Red rooms indicate “alarm”. 
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 Utilities View 
 
“Utilities View” can be accessed through the icon as circled below or on the scroll down 
under “View” on the tool bar.  On the home page the “Utilities View” shows the 
consumption of the total utilities for the entire hatchery.  High or low spikes should be 
observed for problem areas within the system. 
 
 
 
 
 
 
   
 
 
 
By right clicking on the Utilities 
Chart icon on the home page in 
the edit mode, the “Ribbon 
Properties” screen will display 
and the utilities can be logged by 
minutes or hours. 

 
 

 
 
Double click on each room/device for 
individual energy consumption.   
 
 
 
 
 
 
 

 
After double clicking on a room/device a screen will 
appear with the energy consumption and individual 
features for the controls. To the right are the 
monitors for the actual temperature and humidity 
readings and set points for the specific room 
“Hatcher 1”. 
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Charts - Trending 
 
In the CMaestro system, you can trend the 
temperature and humidity readings of each Chick 
Master device that communicates to the network 
system. 
 
You can view 
the charted 
trending results 
of each 
room/device in 
the edit or non-
edit view.  Click 
on the 
room/device 
you wish to 
view which will 
display the 
hatch marks 
around the 
room/device 
and then click 
on the chart icon at the top of your screen. 
 
 
 
The “Graph” 
screen of the 
room will 
appear. Choose 
features to be 
charted and the 
time line you 
would like to 
view.  Save 
settings after 
features are 
chosen.  You 
may also view 
the complete 
chart by 
clicking on the 
small button to 
the left of the 
chart name. 
 
 
 

Hatch 

lines 

around 

room. 
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Charts – Trending (continued) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
You can scale the graph by setting up the Y axis range after pressing “Y Axis button” 
 

 
 
 
  

When these room characteristics are checked, the 
graph will display these values according to the 
chosen time line.  The room characteristics will 
vary depending on machines and controls. 

After pressing the Y Axis 
button, the Y scaling display 
will appear as shown to the 
left.  Default numbers will be 
displayed but can be 
adjusted as needed.  
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Charts – Trending (continued) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Alarm Log 

 
The alarm log can be accessed by clicking on the icon at the top of the screen. 
 
 
 
 
 
 
 
 
 
 
The alarm log keeps a running record of  
alarms occurring with description, location, 
 zone, start and end time, and notifications. 
 
 
 
 
 
 
 
 

You can compare graphs with other machines by checking the compare box and 
then press the setup button. Compare rooms and values viewed on the graphs 
(temp, humidity, pressure, etc. depending on machines and controls) with other 
machines/rooms. 
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Calendar 
 
The calendar can be accessed by clicking on the calendar icon at the top of the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Complete task information for calendar usage.  Can edit tasks by clicking on task or can 
mark complete or delete by right clicking on tasks. 
 

Show Maintenance Items       Show Transfer Items         Show Misc. Items     Print 

Show All            Show Set Items      Show Hatch Items         New Task 

This screen displays the calendar and the 

assigned tasks listed and marked on the 

calendar.  The icons at the top of the screen 

are common tasks for a hatchery business. 

Click on a line to the right of the calendar to 

create a “New Task” or on a day on the 

calendar. 
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Remote Alarm Screen 

 
The remote alarm screen can be accessed by clicking on the icon at the top of the screen. 
 
 
 
 
 
 
 
 
The alarm screen as shown to the right 
will display on the control panel if no 
remote screen is connected, otherwise 
it will only display on the remote 
screen.   
 
The hatchery layout will be displayed 
with the rooms and machines.  The 
rooms/machines will be color coded as 
to the current condition of each 
room/machine.   
 

When no alarms are active the “Alarm 
Screen” is blank with no alarms listed 
on the indicator section and all 
rooms/machines will be displayed as 
green as shown to the left. 
 
The room/machine colors indicate the 
following condition: 

– Green = OK  
– Red = Alarming  
– Dark Gray = Off Line  
– Blue = Communication 

Loss  
 
 
 
 
 
The remote screen can be mounted 50 feet away 
from the computer.  It should be mounted in a 
common area of the hatchery where it will be 
safe from temperature and humidity.   
 
 
 
 

Indicator Section 
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Remote Alarm Screen (continued) 

 
 
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                          
To set up the double screen, follow 
these directions.  Plug the second 
monitor into the computer.  Left click 
the mouse on the desktop screen to 
bring up the message as shown to 
the left.  Click on the screen 
resolution. 
 
 
 

 
 
Follow the screen directions and choose 
preference of screen appearance.  Click 
on “Detect/Identify” and designate Screen 
1(usually on right) as the control screen 
and Screen 2 (usually left) as the remote 
screen. Choose the highest screen 
resolution available.  Landscape 
orientation is recommended. 
Multiple displays should be marked to 
“Extend these displays”.  Depending on 
monitors these descriptions may vary 
slightly but will usually be similar.  
 
 
 
When the remote screen is 
hooked up, click on the alarm 
icon on the control screen to 
pull up the “Alarm Screen”.  
Click on the “Restore Down” 
button on the tool bar.  With 
the mouse cursor on the top 
tool bar of the “Alarm 
Screen”, hold down on the cursor and drag the 
screen to the left where the remote screen is.  
When the “Alarm Screen” has disappeared onto 
the remote screen, without moving the mouse, 
double click to expand the “Alarm Screen”.  The 
remote screen should now have the entire screen 
filled with the “Alarm Screen”. 
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Setpoints 
Only Available for Maestro System 

 
 
Each machine within the hatchery can be set with setpoints for:  humidity, CO², 
temperature, damper, auxiliary fan, turning, cool, and fan (speed, direction, and 
forward/back).  These setpoints will be fixed setpoints unless stage programming has 
been implemented which will then cause fluctuations of the setpoints depending on 
stage.
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Stage Programming   
Only Available for Maestro System 
 
The stage program is used to plan and manipulate the hatchery variables to produce the 
desired environment for the fertile eggs and chicks within the confines of the working 
hatchery. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
GEN4 Stage Programming (20 Stages): 

To access the stage program, click 
on ‘View’ and scroll down to ‘View 
Stage Program. 
 

A blank spreadsheet will be opened with the 
variable functions as shown with the icons for 
creating a staging program at your hatchery. 
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Duration of stage 

Temperature Setpoint 

High Temperature Alarm Setpoint 

Low Temperature Alarm Setpoint 

Humidity Setpoint 

High Humidity Alarm Setpoint 

Low Humidity Alarm Setpoint 

CO₂ Setpoint 

High CO₂ Alarm Setpoint 

Low CO₂ Alarm Setpoint 

Manual Damper Setpoint 

Minimum Damper Setpoint 

Damper Control Mode ** (see next page) 

Turning Tilt Time 

Turning Level Time 

Damper Aux Fan Activation Setpoint 

Auxiliary Fan Mode ** (see next page) 

Cooling Mode ** (see next page) 

Fan Speed Status:  0=Auto    1=Manual 

Fan Speed Set When In Manual 

Fan Direction Status:  0=Auto    1=Manual 

Two Directions:  0=Forward     1= Reverse 

Forward time in minutes 

Reverse time in minutes 

Stage Programming (continued) 
Only Available for Maestro System 

 
 

      
The icons to the left are variables that 
can be regulated for stage 
programming. 

 
 

 



29 

 

 
 

Stage Programming (continued) 

Only Available for Maestro System 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

** Damper Control Mode 

0 Manual 

1 Temperature 

2 Humidity 

3 CO2 

 

** Auxiliary Fan Mode 

0 Snowflake On With Cooling 

1 PLC Auto  (Auto Status) 

2 Maintenance (Manual Status) 

3 Off 

 

** Cooling Mode 

1 Water then Air 

2 Water and Air 

3 Air then Water 

4 Air Only 

5 Water Only  
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Stage Programming (continued) 

Only Available for Maestro System 
 
 
GEN3 Stage Programming (10 Stages): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
GEN3 Stage Programming (8 Stages): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

◼ When stage programs are less than 10 stages, the un-programmed stages will 

appear dark gray and have a value of 0. 
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Stage Programming (continued) 

Only Available for Maestro System 

 

ULTRA Stage Programming (10 Stages) 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
◼ Damper Minimum: used only with Pro Set and Pro Hatch.  

 
 
 

ULTRA Stage Programming (5 Stages): 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
◼ You can see when you program less than 10 stages; the un-programed Stages will 

appear gray and have a value of 0. 

◼ Damper Minimum: used only with Pro Set and Pro Hatch.  

 

See note below 

See note below 

Type of the machine 
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Stage Programming (continued) 
Only Available for Maestro System 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

  

◼ If the machine and controls do not match, an error screen will display until 

corrected. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

◼ A progress screen will be displayed when verifying the correct controls and 

machines. 
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Directory: where the stage program file 

is saved on the computer 

To set how many stages 

Type of the machine 

A list of machines uploaded 

 

Stage Programming (continued) 
Only Available for Maestro System 

 
 
 
 
 
 
 
 
 
 
 

 

Buttons 
 
 
 
 
 
 
 
 
 
  

*  You can open csv file using Microsoft Excel. 
 ** Make sure you upload the matching type of machine, otherwise you  
     will receive an error. 
 

 Modifying/Changing Values 
◼ Follow the provided steps to change the value of a cell: 

1. Click on the cell you want to change. 

2. Type the number you want. 

BUTTON USEAGE  

Open Opens a previously saved Stage program 

Save Overrides the old stage program file with the current one 

Save as Saves the current stage program as anew stage program file 

Export Exports the current stage program to csv file* 

Upload Uploads the stage program from the machine** 

Send Sends the current stage program to the machine 
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Stage Control   
Only Available for Maestro System 
 
The stage control is used to manage the stages set for the machines.  If the stage 
program has been set in action, the control will be in the ‘Go’ mode.  If a stage needs to 
be stopped, the ‘Stop’ mode will be pressed.  At this time, the machine will maintain the 
last setting until further action is taken.  If a stage needs to be moved forward or 
backward, the change button can be utilized to produce the desired environment for the 
fertile eggs and chicks within the confines of the working hatchery. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
  

Machine name 

will be displayed  

in this box. 
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Setting Up a CC3 Device 
Only Available for Maestro System 
 
 
To add the CC3 to the Network, you will need: 
 

1. Access to the Maestro Edit Mode 

2. A sensor layout of the building (provided by Chick Master) 

 
On the Hatchery overview, double click the room you want to add the CC3 room details. 
For this example we will add 2 Plenums and Room data. 
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Sensor Layout Example:  
Only Available for Maestro System 
 

Note one plenum for the setter room and two separate hatcher rooms each with one 

plenum pressure as shown           in the circles.  The plenum pressures can be controlled 

either by a motorized damper as shown          in the ovals.  There are three sets of 

temperature and humidity sensors, one for the setter room, and one set for each of the 

two hatcher rooms as shown       in the diamonds.  The individual room pressure for each 

of the three areas is shown     in the rectangles.  The exhaust fans are shown        in the      

triangle shape.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

 
 
 
 
 
 
 

EF1 

EF2 EF3 

EF =   EXHAUST FAN 
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Setting Up a CC3 Device (continued) 
Only Available for Maestro System 
 
 
 
 
 
 
While in Room View, right click 
the area where you will add the 
first plenum and select the 
Room Controller Option for 
“CC3 Plenum.” 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 
 
Select the area you want the 
first Plenum to be 
represented. 
 
 
 
When prompted, enter the 
com port details and node 
address, as well as the 
plenum name, if desired. Set 
the plenum as “Online” to 
enable data retrieval.
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Setting Up a CC3 Device (continued) 
Only Available for Maestro System 
 
 
 
 
 
 
Click “File> Save” 
to save the 
changes.  
When saved, the 
option to select 
the sensor 
elements in the 
properties will 
now be available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
So now right click 
on the Plenum 
and go to 
“Properties.” 
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Setting Up a CC3 Device (continued) 
Only Available for Maestro System 

 

Now with the “Elements…” option available, click it and select the sensors dedicated to 
that plenum as shown on the building sensor layout provided by Chick Master.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Select the sensors from the drop down list that correspond to the sensors on the layout. 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
When finished, click “ok” to both boxes and Save 
your changes via the “File>Save” menu.  
 
 
Do these same steps for Plenum 2. 
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Setting Up a CC3 Device (continued) 
Only Available for Maestro System 
 
 
Adding the room details is a very similar process. Right-click and select, “New Room 
Controller>CC3 Room”. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Draw the room out in the space in-
between the incubators. You will be 
prompted for a room name, com 
port and address settings, and 
online/offline. Select Online to 
enable data retrieval. 
 

 

 

 

 

Click “Ok” and save these 
changes. This will enable the 
“Elements…” section to be 
accessed. 
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Setting Up a CC3 Device (continued) 
Only Available for Maestro System 
 

 

 

 

 

Now with the changes 
saved, right-click the 
room and go to 
“Properties”.  
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the       
“Elements…” 
button. 
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Setting Up a CC3 Device (continued) 
Only Available for Maestro System 
 

 

Much like the plenum you’ll be given a series of drop downs for each of the sensors. 
Using the Building sensor layout as your guide select the corresponding sensors, 
leaving them set to “unused” for items that are not available to this room. Under the 
Plenum 1 and 2, use the same settings as for the previous plenums for the selections. 
The room will show all the sensors at once, while the plenums only show the specific 
plenum data. 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Setter Room 1 

Setter Room 1 
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Setting Up a CC3 Device (continued) 
Only Available for Maestro System 
 

Once finished selecting the sensors, click “ok” and before leaving the properties box, be 
sure to set the wattage for each of the utilities. This step is optional, but necessary, if 
using the energy usage estimator. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
Now that the setup is complete, save your 
changes via the “File>Save” menu. 
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Step-by-step Instructions to Update Maestro Software 
 

These step-by-step instructions will guide you through the updating of your current 
Maestro software. 
 
You can either: 
A) Download the program to a USB flash memory stick and install it on the Maestro PC. 

or   
B) If you have Internet access available on the Maestro PC, you can do it directly on the 

Maestro PC.  
 

Follow the instructions below. 
 
Prior to down loading a new Maestro software version, exit previously installed version.  
 
Save a copy of your existing version, by going here: 
 

C:\ChickMaster 
 
Select the “CMaestro” directory and with the mouse cursor over it right click, go to “Send 
to” and click on “Compressed (zipped) folder”. 
 
 

Name the new folder and save it.  
The folder name should be easily 
identified for future reference.  We 
recommend using the date for 
identification when saved which will 
be saved sequentially.  It is very 
likely a hatchery will need to refer 
back to graphs of different time 
periods for comparison.  By saving 
these files, you will be able to unzip 
and recreate your copy of Maestro, 
the exact version, layout and data 
as when you zipped it. Over time, 

you will have multiple backup zipped copies and you will be able to restore to the time 
period that fit current production.   
 
 
 
You folder will look like this after you’ve zipped up a copy and named it “CMaestro Saved 
April-9-2015”. 
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Step-by-step Instructions to Update Maestro Software (continued)  

 
 
Start by clicking on this link to bring up a web page on the Chick Master web site: 
 

http://www.chickmaster.com/product-categories/integrated-hatchery-management/ 

 
Scroll down to ‘Keep your Maestro or Advisor System Up-to-Date’.  Click on the ‘click 
here’ text and complete the information requested and hit submit, which will then direct 
you to the download page for the most recent version (v20XX.XX.XX) of Maestro:   

 
 
 
Click on “Download Maestro 
v20XX.XX.XX”, the actual date of 
the release will be in place of the 
“20XX.XX.XX”.  

 
 
 
 
 
 
 
 

 
Save the download.  
(At this time you may save the file onto a USB flash memory stick to transfer it to the 
Maestro PC if not directly hooked to internet and copy to hard drive.) 
 
With the download file on the Maestro PC hard drive, click on the new version file. 
 
In Internet Explorer the file is in the “Downloads” folder. You should get a dialog box that 
will allow you to run the program. You can find it later by going to “Tools\View 
Downloads”. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

http://www.chickmaster.com/product-categories/integrated-hatchery-management/
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Step-by-step Instructions to Update Maestro Software (continued)  

 
Your next window will be Windows Explorer.  
 
Double click on the “CMaestro Installer v201X.XX.XX” application. 
 
Click on “Run”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Setup dialog box will appear on screen.  
 
Reminder:  shut down the previously installed older version and exit it, prior to 
continuing.  
 
Click on “Next”: 
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Click Upgrade before Finish! 

Step-by-step Instructions to Update Maestro Software (continued)  

 
 
Click on “Install”: 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
The Maestro software is updating an existing version. 
  
The next dialog screen will be “Completing the CMaestro Setup Wizard”. 
 
The “Run CMaestro” will and should be checked to run the program.   
 

*** Be sure to click on “Upgrade from Previous Installation…” in order to keep your 

hatchery layout and machine data, otherwise this information will not be included in the 
upgrade. 
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Step-by-step Instructions to Update Maestro Software (continued)  
 
 
 
Click on “Yes” to continue. 

 
 
 
 
 
 
 
Click on “OK”. 

 
 
 
 
 
 
 
Click on “Finish”. 

 
 
 
 
 
 
 
 
 
 
When Maestro appears on the screen, it is the same version as the download link.   
 

 
 
 
You will note the new 
“20XX.XX.XX” version will be 
visible in the upper left border of 
Maestro when it is up and 
running on the PC. 
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Do not check box. 

 

Re-Installing Maestro Software  

 
1. Shut down the Maestro. 

2. Navigate using windows explorer to C:\ChickMaster directory 

3. Create a backup by right clicking the CMaestro folder. 

4. Select send “Send to Compressed (zipped) folder. 

5. Move the zipped CMaestro folder, the license file “cmhn.lic” from within the CMaestro 

directory and the “header.dta” from within the Data directory to a safe folder outside 

of the ChickMaster directory. 

 

 

 

6. Delete the ChickMaster directory. 

7. Go to the  

http://www.wolfcreekmicro.com/maestro.htm 

 and download the latest version of Maestro.  

8. When installing do not choose to upgrade  

from previous version.  

9. Uncheck the “Run CMaestro” box. 

10. Select “Finish” 

11. Before running Maestro put the 

“cmhn.lic” into the newly created 

CMaestro directory. 

 

 

12. Before running put the “header.dta” 

into the newly created data directory. 

13. Run Maestro, if done correctly Maestro 

should start up with all the machines      

                                                                               displayed and hatchery components          

                                                                               present. If there is a problem return    

                                                                               back to the original state using the        

                                                                               backup. 

http://www.wolfcreekmicro.com/maestro.htm
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INSTRUCCIONES PARA LA INSTALACION  
DEL SOFTWARE DE RED MAESTRO 
PARA LA PLANTA DE INCUBACION 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Notas sobre los Derechos de Autor 

Derechos de Autor © 2016 Chick Master. Todos los Derechos Reservados. 
Ninguna parte de esta publicación puede ser copiada sin el permiso expreso y por escrito de 

Chick Master, 945 Lafayette Road, Medina, Ohio 44256 
 

www.chickmaster.com 
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Instalación 
 
 

El Programa de Red Maestro-Advisor para Plantas de Incubación no requiere un 
procedimiento formal de instalación. Si usted compró el sistema de red de Chick Master, 
ya está instalado dentro de una carpeta en el escritorio de su computadora. Nos 
referimos al sistema de red Maestro. El Sistema Advisor es idéntico al sistema Maestro, 
con la excepción de que las opciones de Puntos fijos, la Programación por Etapas y el 
Control de Etapas son disponibles únicamente en el sistema Maestro. 
 

Dentro de la carpeta, usted verá los archivos: A “maestro.exe”, “oracle.exe”, o 
CMHN.exe” y una copia de seguridad titulada “cmhn.lic”. 
 

El archivo maestro.exe es el archivo de la aplicación.  
 

El archivo cmhn.lic es el archivo de la licencia. Haga una copia de seguridad de este 
archivo, y ¡guárdela en un lugar seguro! 
 

Después de ejecutar la aplicación por primera vez, usted verá un archivo nuevo en la 
misma carpeta, titulado “*.dta”. Este archivo contiene todos los datos adquiridos y 
guardados por el Programa Maestro. Los archivos “*.dta” se guardan en c: 
usuarios\nombre del cliente: 
 

Cada vez que usted crea o elimina una sala o máquina, la base de datos re-inicializa el 
archivo de datos. Si se ha acumulado un volumen importante de datos y desea añadir 
una máquina nueva, recomendamos hacer una copia de seguridad en otro sitio antes de 
añadir la máquina nueva a la aplicación del Maestro. 
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Copia de Seguridad  
 
Para los propósitos de Chickmaster, siga las siguientes instrucciones para Backup 
(Copia de Seguridad) y recuperación: 
 
1. Haga doble clic en Acronis True Image Home 2012. 
2. Haga clic en Backup (Copia de Seguridad). 
3. Haga doble clic en Disk (Disco) y Partition Backup (Partición de Copia de Seguridad). 
4. Asegúrese de que se vea la unidad C. 
5. El destino debe ser H:\mybackups (Mis Copias de Seguridad) (H debe ser su segundo 
disco duro). 
6. Activar Schedule Option (Opción de Horario) para que copie los datos en un horario 
programado. 
7. Esquema de Backup (Copia de Seguridad): Incremental. 
8. Backup name (Nombre de la Copia de Seguridad): puede cambiar esto a algo que le 
deja saber que va a copiar a la C drive, o deje el disco H como mis particiones. Haga clic 
en Backup (Copia de Seguridad) ahora. 
 

Siga las instrucciones a continuación para Backup y recuperación adicional 
1. Haga doble clic en Acronis True Image Home 2012. 
2. Haga clic en Backup. 
3. Haga clic en cmaestro (Esto es para crear una copia de seguridad de todos los 
archivos del cmaestro). 
4. El destino debe ser H:\mybackups (H debe ser su segundo disco duro). 
5. Activar la opción de horario para que copie los datos en un horario programado. 
6. Esquema de Backup (Copia de Seguridad): Incremental. 
7. Backup name (Nombre de la Copia de Seguridad): cree un nombre nuevo, o déjelo 
como mybackup. Haga clic en Backup Now (Crear una Copia de Seguridad ahora). 
 
 

Exención de Responsabilidad 

 
 

El sistema de notificación del Maestro depende de una buena conexión a 
internet. 
 
En el caso de perder la conexión de internet, el sistema no podrá enviar 
notificaciones por medio de mensajes de texto y emails. 
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Resumen de la Barra de Herramientas  
 

Por favor, lea todas las instrucciones y téngalas como referencia al crear su planta de 
incubación. 
 
Al abrir el Maestro, usted verá cuatro opciones en la barra de herramientas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

La opción “File” se despliega 
con un menú así: 
 

La opción “About” se despliega 
así: 
 

La opción “Hatchery” muestra el 
siguiente menú: 
 

La opción “View” abre el  
siguiente menú: 
 

Vista de Mapas    página 16 
Vista de Servicios   página 17 
Vista de Gráficos   página 18 
Vista de Registro de Alarmas  página 20  
Calendario    página 21 
Pantalla Remota de Alarmas página 22 
Puntos Fijos    página 24 
          (Ver y editar los puntos fijos de la máquina.)   
Programa por Etapas  página  25 
          (Ver y editar los programas por etapa.)  
Control de Etapas   página 32 
          (Cerrar/Detener o cambiar la etapa.) 
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Configuración del Código 
 
Una vez instalado y funcionando, se presentará una hoja en blanco que se usa para 
configurar su planta de incubación. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Usted necesita un código de acceso para proceder. El código de acceso “1881” le 
permite crear su propio código de acceso. Esto se debe crear de inmediato; más 
adelante el usuario no podrá tener acceso para crear o cambiar el código de acceso.  
 
En la barra de herramientas en la parte superior de la pantalla, a la izquierda usted verá 
las palabras File, Hatchery, View y About.   Haga clic en “Hatchery” y se desplegará un 
menú. Busque “New Passcode” y haga clic para ver una pantalla titulada “New 
Passcode”. Ingrese 1881 en el espacio superior, y el código de acceso nuevo (letras y/o 
números) en el espacio de “New pass code”, y vuelva a ingresar el mismo código nuevo 
en el espacio “Confirm pass code”. Toque “OK”. 
 
 
 
 
 
 
 
 
 
 
 
Desde “Hatchery”, en el menú desplegable, seleccione “Edit Mode”, y verá la pantalla de 
“Edit mode log in”. Ingrese su código de acceso nuevo y toque “OK”. 

1881 

***** 

***** 
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Exportar 
 
 

 
 
En el menú desplegable de “File”, usted verá tres 
opciones para exportar.   
 
1.  La opción “Export Machine Data” exporta los datos en 
un archivo “tda” al lugar en el Directorio de Exportaciones 
configurado por el operador.  
 
 

 
Configuraciones, ítems, la frecuencia del auto-exportación y el directorio de 
exportaciones pueden verse en la pantalla mostrada abajo.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  El Registro (“Export Alarm Log”) exporta como un archivo “dta” al directorio de 
máquinas exportadas.  
 
3.  La opción “Export Hatchery Layout” exporta el plano principal de la planta de 

incubación formateado como un archivo “dta”, para que sea fácil 
mover el plano a otra computadora.  
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Configuración del Plano de la 
Planta de Incubación  
 
 
Estando en el modo editar, la pantalla se 
despliega como papel cuadriculado.  
 
 

 
 
 
 
 
Haga clic con la derecha en la 
parte cuadriculada y clic con 
la izquierda sobre el texto  
 “New Room” que aparece  
junto al cursor en forma de 
flecha, la cual se cambia en 
“+”.   
 

 
Haga clic y arrastrar el ratón para crear una sala 
cuadrada/rectangular de color gris sólido. Esta será la 
primera sala de su planta de incubación.  
  
 
 

 
Al crearse la sala, una pantalla aparece 
titulada “Room Properties” donde se debe 
ingresar un nombre para la sala. Ingrese el 
nombre de la sala y toque OK. El nombre 
de la sala se verá en la esquina superior 
izquierda del área gris.   
Usted puede crear tantas salas que sean 
necesarias, teniendo cuidado de no 
sobreponerlas. Si alguna queda 
sobrepuesta, simplemente haga clic y 
mantenga apretada el mouse moviendo la 
sala al lugar deseado. 
Para poder ajustar el tamaño de una sala, 
haga clic en la esquina derecha inferior de 
la sala y mover el mouse hasta conseguir 
el tamaño deseado. 
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Configuración del Plano de la Planta de Incubación (continuación) 

 
Después de poner el nombre a la sala, se 
puede ingresar a la sala de 2 formas. Coloque 
el cursor en el recuadro gris para seleccionar 
el recuadro. Usted puede hacer doble clic 
para ingresar al área marcada, o puede 
colocar su cursor en el ícono de la lupa “+” en 
la barra de herramientas en la parte superior 
de la pantalla. 
 
 
 
 
 
 
Para salir de una sala, haga clic en  
1. La casita que hace volver al papel 
cuadriculado o 
2. El ícono de la lupa “ –“, que le hace 
volver una ventana a la vez.  
Si intenta salir con “X”, se le preguntará 
si desea cerrar el programa. 

 
 
 
 
 
Al entrar a la sala, usted puede hacer clic con la 
derecha para ver un menú con opciones así.   
Usted puede elegir una opción, o ninguna de las 

opciones.  
Si elige “Properties”, se puede modificar el 
nombre de la sala. 
 
 
 
 
 
 

El cursor se puede colocar en el nombre de la 
sala y mantenerlo/arrastrarlo a cualquier área 
gris de la sala. También se puede aumentar o 
reducir el texto al colocar el cursor en la esquina 
derecha inferior; el cursor se cambia en 
flechas para ajustar el tamaño del 
nombre.  

Haga clic en la lupa “+” 
                   o 
haga doble clic sobre el 
recuadro gris para 
ingresar a la sala. 

1 2 
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Configuración: Propiedades de las 
Incubadoras    
 
Al ingresar a una sala creada, usted puede hacer clic 
con la derecha para elegir una de las opciones. Una 
opción es “New incubator”. Cuando se elige el “New 
Incubator”, mueva el cursor a la flecha a la derecha 
para ver el menú desplegable de las opciones de 
controles para su máquina. Busque la opción 
correcta de la lista, y selecciónela.  

 
 
 
 
 
 
El cursor se cambiará a  “+”.  Arrástrelo 
para colocar la incubadora dentro de la 
sala. La pantalla de las propiedades de la 
incubadora aparecerá, pidiendo la 
información mostrada a la izquierda. 
Ingrese el nombre y las otras 
características de la incubadora que se 
pide, según el tipo de control.  
 
 
 

 
 
Note que el “Com Port” 
también tiene una lista 
desplegable para 
acomodar múltiples 
puertos de comunicación. 
 
Si las máquinas se 
encuentran fuera de 
servicio, o se está 
realizando mantenimiento 

o arreglos a la máquina, 
usted debe hacer clic en 
“Off Line”. Se verán gris 
oscuro y las alarmas para 
estas salas no estarán 
activadas 
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Doble clic 

 

Configuración: Propiedades de las Incubadoras   (continuación) 
 

                                                                                                                                                                                                                
Después de poner el 
nombre a una incubadora y 
añadir sus valores, se verá 
similar a lo que mostramos 
a la izquierda. 
 
El operador puede hacer 
doble clic en la sala de las 
incubadoras y aparecerá la 
pantalla mostrada abajo, la 
cual muestra los monitores 
individuales para cada 
variable del control elegido; 
en este caso es el Génesis 
IV.  Más adelante en este 
manual explicaremos acerca 
de estos monitores.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Para salir de esta pantalla y regresar al plano principal, haga clic en el ícono de la lupa  
“      ”. 
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Configuración de la Identidad (ID) de las Zonas     
 
La identidad de la Zona también se describe como la ‘ID del Nodo’ y / o ‘Dirección de la 
Red’. Múltiples ID de Zonas son utilizadas en las máquinas con controles GeMeric, GemO 
o GeM. Todo otro tipo de máquina usa solamente una ID de Zona. 
El uso de múltiples ID de Zonas se determina por el usuario según la cantidad de zonas 
que tiene una máquina. Cada zona requiere su propia ID de Zona, como también la 
humedad. Todas las otras máquinas usarán una Zona y una ID de Nodo. El puerto COM 
correcto debe ser seleccionado para conectar la red correctamente.    
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Controlador de la Sala – 

las escalas de temperatura 

y de humedad. 

El controlador de la sala al finalizar el ingreso 

de los valores. Haga doble clic en la sala arriba 

para ver la pantalla a la izquierda con  la escala. 

1.) Ingrese los valores en “Room 

Controller Properties” 

Configuración: Propiedades de  
los Controles de las Salas 

 
Al hacer clic con la derecha dentro de una sala, una 
lista desplegable proveerá las opciones del  
 “New Room Controller”.  Coloque el cursor sobre 
la flecha a la derecha para ver la lista de opciones. 
Busque y seleccione el control que corresponde a 
su sala.    

 
 
 
 
 
 
 
 
 
 

 
El cursor se cambia en “+”.  Arrástrelo 
para colocar el controlador dentro de la 
sala. La pantalla siguiente aparecerá para 
solicitar la información/los valores como 
indicado en la figura a la derecha, y se 
verá diferente, según el control elegido 
para la sala. 
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En la área izquierda 
inferior  usted verá 
una ventana con una 
lista desplegable para 
configurar la demora 
del temporizador 
antes de que las 
notificaciones activen 
la alarma.   

Configuración: Propiedades   
del Nuevo Centro de Alarmas 
 
Se colocará una sola alarma dentro de la sala de incubación, y su ubicación es una 
decisión individual. Generalmente está ubicado en el medio y fácilmente accesible. 

 
Haga clic con la derecha dentro de una sala 

para ver la lista que contiene la opción  “New 
Alarm Center”.  El cursor se cambia en “+”.  
Arrástrelo para colocar el Centro de Alarmas 
dentro de la sala.  
 

 
 

 
 
Se verá esta pantalla con las propiedades 
del marcador: “Dialer Properties”.  Complete 
el Puerto Com y la ID de la Comm (identidad) 
Luego haga clic en la opción “Alarm Center” 
en la esquina inferior izquierda. 
 
                  

 
 

Se abrirá la pantalla de propiedades del 
Centro de Alarmas como mostramos a 
la izquierda. 
 
Se debe verificar la lista de 
notificaciones para bocina, luz, 
marcador, y *contactos (*vea contactos 
en la siguiente página para los detalles). 

 
 

 
                                                                                                                                                      

 
 
 
 
 
 
 
 
 
Se debe configurar las notificaciones de 
desactivación para los días y horas cuando no 
debe estar activada.
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Haga doble clic en “Alarm 
Center”para ver la pantalla 
de Comunicación del Centro 
de Alarmas. 

Configuración: Propiedades   
del Nuevo Centro de Alarmas (continuación) 

 
 
 
Abajo de las notificaciones de 
desactivación vemos el botón “Contacts” 
para ver los contactos. 
 
 
 
 
    

 
Tóquelo para ver la pantalla de 
“Contacts”.  Ingrese los números 
telefónicos, los proveedores de 
servicios, los nombres y direcciones 
de correo electrónico de las 
personas que deben ser informadas 
en el caso de alarmas específicas. 
Además, las personas pueden recibir 
notificaciones para tareas de 
mantenimiento, la colocación y 
transferencia de huevos y otras 
tareas.   

 
 
 
 

 

 

 

 

Además de modificar los contactos y / o las 
alarmas y notificaciones desde el “Alarm 
Center, también puede tener acceso a través 
de “Hatchery” en la barra de herramientas, 
donde se despliega una lista que contiene 
“Contacts” o “Alarm Center Properties”. 
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Configuración: Propiedades del Enfriador 
 
Si un enfriador de agua es parte de la planta, se 
puede crear una sala nueva, y sobre la misma hacer 
clic con la derecha para seleccionar la opción “New 
Chiller”.   
 
El cursor se 
camba en “+”.  
Arrástrelo para 
colocar el 
enfriador dentro 
del área. La 
pantalla de las 
propiedades del 

enfriador aparecerá, y se debe ingresar la información 
indicada en la figura a la derecha. Ingrese los datos 

correspondientes a 
la planta de 
incubación. 
 
Una vez creada la sala del enfriador, el operador 
puede hacer un doble clic sobre la sala del enfriador 
para desplegar la temperatura caliente que ingresa al 
enfriador y la temperatura fría que sale del enfriador. 
También la presión es desplegada. Si la línea 
ondulado entre la temperatura caliente y fría no se ve, 
se activará una alarma indicando que hay problemas 
con el flujo de agua. 

   
Vista General 
 
Ahora su planta de incubación se verá así, y se puede ver de esta manera en cualquier 
momento al hacer clic en el 
ícono “Map”.  Nota:  Aquí vemos 
el formato “non-edit”. (no editar) 
 
En esta sección, veremos lo más 
básico de cómo usar el CMaestro 
para monitorear mejor el estado 
de su planta de incubación.  
 
Desde la pantalla principal, usted 
podrá ver cada sala de la planta. 
 
Las salas equipadas con  
Sistemas de Control para las Salas, como se podrá ver, informan y registran las 
tendencias de la temperatura y la humedad de las salas. 
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– Blanco = OK 
– Rojo = Condición de Alarma 
– Gris = Fuera de Línea 
– Azul = Pérdida de Comunicación 

 

Azul-Pérdida de Comunicación 

Rojo - Alarma 

Vista General (continuación) 
 
Los colores de la máquina indican el 
estado de la máquina. 

  
      

 
     Tipo de Control: Gen IV  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

Indicador : 
Incubadora o 
Nacedora 

Actual Punto Fijo 

PF. Alarma Alta 

Lectura Actual 

PF. Alarma Baja 

Salidas Modo 
Alarmas 

Volteo 
Contador Volteo 
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Indicador Global del Estado de la Planta y Mapa 
 
 
 
 
 
 
 
 
 
 
 
 
     
    ALARMA, el indicador es ROJO. 
 
 
 
 
 
 
 
 
 
   

El Indicador Global del Estado de la Planta se despliega en forma de un ícono de un 
globo verde, o una alarma dentro de un globo rojo, encontrado en la barra de 
herramientas. Esto permite al operador  monitorear la planta entera desde cualquier 
pantalla.  
                                            SIN ALARMA, El indicador es verde.                       
                

Red rooms indicate “alarm”. 

Estando en el ícono “map”, se ve un plano de la planta de incubación en 
miniatura al lado del Indicador Global del Estado de la Planta de Incubación. 
Salas verdes = Éxito  (Ninguna Alarma) 
Salas rojas = Falla  (Alarma) 
Salas amarillas = Fuera de servicio 
Salas azules = Pérdida de Comunicación 
 Map Icon 

Las salas verdes = No existen alarmas 

Las salas rojas = “alarma”. 
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 Vista de Servicios 
 
Se puede lograr acceso a la Vista de Servicios (“Utilities View”) a través del ícono 
mostrado abajo, o desde la lista desplegable de “View” en la barra de herramientas. En la 
página principal, la “Utilities View” despliega el consumo de todos los servicios de la 
planta entera. Los picos altos y bajos indican las áreas de problemas dentro del sistema.  
 
 
 
 
 
 
   
 
Al hacer clic con la derecha en el 
ícono del Gráfico de Servicio en la 
página principal, en modo editar, 
se desplegará el cuadro de 
“Ribbon Properties” desde donde 
se puede registrar los servicios 
por minuto o por hora.  
 
 

 
 

 
Hacer doble clic en cada sala / sistema para 
ver el consumo energético individual.    
 
 
 
 
 
 
 
 
 

Después de hacer doble clic en una sala / sistema, 
aparecerá un cuadro con el consumo energético y las 
características individuales de los controles. A la 
derecha se ve los monitores para las lecturas actuales 
de la temperatura y la humedad, y puntos fijos 
específicos para la sala “Hatcher 1”  
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Análisis de Tendencias – Gráficos 
 
En el sistema CMaestro, usted puede registrar 
las tendencias de las lecturas de temperatura y 
humedad de cada sistema Chick Master que se 
comunica con el sistema de red. 
 
Usted puede ver 
los resultados 
de las 
tendencias 
registradas de 
cada sala / 
sistema en la 
vista editar o 
no-editar. Haga 
clic en la sala / 
sistema que 
desea ver, y 
aparecerán 
líneas de 
rayado 
alrededor de la sala / el sistema, y haga clic en el ícono del gráfico en la parte superior de 
la pantalla.  
 
 
La pantalla del 
gráfico “Graph”  
aparecerá. Elija 
las opciones 
que usted 
desea graficar y 
el período de 
tiempo que 
desea ver.  
Guarde los 
ajustes 
después de 
elegirlos. 
También se 
puede 
completar el 
gráfico al hacer 
clic en el botón 
pequeño a la 
izquierda.  
 
 
 

Hatch 

lines 

around 

room. 
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Análisis de Tendencias – Gráficos (continuación) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
Usted puede escalar el gráfico al tocar el botón “Y Axis” para configurar el alcance del 
eje Y. 
 

 
 
 
  

Al estar seleccionadas estas características de la sala, el 
gráfico mostrará estos valores según el período de 
tiempo elegido. Las características de la sala variarán 
según las máquinas y los controles.  

Después de tocar el botón 
“Y Axis”, la escala Y se verá 
como la figura a la 
izquierda. Los números por 
defecto que se despliegan 
pueden ser ajustados según 
sea necesario.  
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Análisis de Tendencias – Gráficos (continuación) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Registro de Alarmas 
 
Para tener acceso al registro de alarmas, haga clic en el ícono en la parte superior de la 
pantalla.  
 
 
 
 
 
 
 
 
 
 
El registro de alarmas mantiene una lista de 
las alarmas ocurridas con la descripción, la 
ubicación, la zona, el tiempo del comienzo y 
el tiempo de finalizarla, como también las 
notificaciones.  
 
 
 
 
 

Usted puede comparar los gráficos con otras máquinas al seleccionar la opción 
“Compare”, y luego “Setup”. Compare las salas y los valores vistos en los 
gráficos (temperatura, humedad, presión, etc. según las máquinas y los controles) 
con otras máquinas / salas. 
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Calendario 
 
Para tener acceso al calendario, haga clic en el ícono del calendario en la parte superior 
de la pantalla.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Complete la información de tareas para el uso del calendario.  Hacer clic en la tarea para 
modificar la tarea, o clic con la derecha para marcar la tarea finalizada o eliminarla. 

Items de Mantenimiento      Items de Transferencia    Items de Miscelánea    

Show All       Colocación de huevos     Nacimiento            

NuevaTNeTask  

Esta pantalla muestra el calendario y las 

tareas asignadas en forma de lista, y en el 

calendario mismo. Los íconos en la parte 

superior de la pantalla son tareas comunes en 

una planta de incubación. Haga clic en un 

renglón a la derecha del calendario, o en un 

día del calendario para crear una tarea nueva. 

Imprimir 

Mostrar todo Colocación  de huevos Nacimiento Tarea Nueva 
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Pantalla Remota de Alarmas  
 
Para tener acceso a la pantalla de alarma remota, haga clic en el ícono en la parte 
superior de la pantalla.  
 
 
 
 
 

 
La pantalla de alarmas en la figura a la 
derecha se verá en el panel de control 
si no hay una pantalla remota 
conectada; de otra manera se verá 
únicamente en la pantalla remota.    
 
El plano de la planta de incubación se 
mostrará con las salas y las máquinas. 
Las salas / máquinas se verán con un 
código de colores según la condición 
actual de cada sala / máquina.  

Cuando no hay alarmas activas, la 
Pantalla de Alarmas no tiene ninguna 
alarma en la Sección Indicador, y 
todas las salas / máquinas se verán en 
verde, como la figura a la izquierda.  
 
Los colores de salas / máquinas 
indican las siguientes condiciones: 

– Verde = OK  
– Rojo = Alarma 
– Gris = Fuera de Línea  
– Azul = Pérdida de 

  Comunicación 
 
 
 
 
La pantalla remota puede estar montada a 50 pies de 
distancia de la computadora. Debe estar en un área 
común dentro de la planta de incubación, protegida de 
las temperaturas altas, las bajas, y la humedad. 
 
 
 
 
 

Sección Indicador 
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Pantalla Remota de Alarmas (continuación) 
 
 
 
Para configurar la pantalla doble, 
siga estas instrucciones: Enchufe el 
segundo monitor en la computadora. 
Haga clic con la izquierda en la 
pantalla del escritorio para ver el 
mensaje mostrado a la izquierda. 
Haga clic en “Screen resolution”.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                       
 
 
 
 

Siga las instrucciones en la pantalla y 
elija las opciones de la presentación en 
pantalla. Haga clic en “Detect/Identify” 
asignar la Pantalla 1 (generalmente a la 
derecha) como la pantalla de control, y la 
Pantalla 2 (generalmente la de la 
izquierda) como la pantalla remota. Elija 
la resolución más alta disponible. 
Recomendamos usar la orientación 
horizontal. (landscape) Donde se elige 
“Multriple displays”, usted debe marcar 
“Extend these displays”.  Según el 
monitor, estas descripciones pueden 
variar, pero por lo general son algo 
similares.   
 
 
Una vez conectada la 
pantalla remota, haga clic en 
el ícono de alarma para abrir 
la pantalla de alarmas.  Haga 
clic en el botón “Restore 
Down” en la barra de 
herramientas.  Con el cursor 
en la barra superior de 
herramientas en la pantalla de alarmas, retenga 
el cursor y arrastre la pantalla a la izquierda al 
lugar de la pantalla remota. Al desaparecer la 
pantalla de alarmas en la pantalla remota, sin 
mover el ratón, haga doble clic para ampliar la 
pantalla de alarmas. Ahora la pantalla remota 
debe estar completa con la pantalla de alarmas. 
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Puntos Fijos   
Disponibles únicamente con el Sistema Maestro 

 
Se puede configurar cada máquina de la planta de incubación con puntos fijos para: la 
humedad, el CO2, la temperatura, el damper, el ventilador auxiliar, el volteo, el enfriamiento, y 
el ventilador (velocidad, sentido y adelantar/regresar). Estos puntos fijos serán puntos fijos 
permanentes a menos que se haya implementado la programación por etapas, que por sí 
provocará variaciones en los puntos fijos según la etapa. 
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Programación por Etapas  
Disponible Únicamente con el Maestro 
 
El programa por etapas es usado para programar y manejar los variables de la planta de 
incubación para producir el ambiente deseado para los huevos fértiles y los pollitos dentro de 
los parámetros de la planta de incubación. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

Programación de Etapas Génesis IV (20 Etapas):

Para tener acceso al programa por 
etapas, haga clic en ‘View’ y seleccione 
‘View Stage Program’. 
 

Se abrirá una planilla en blanco con las funciones 
variables como se ven con los íconos para crear un 
programa por etapas en su planta de incubación.  



78 

 

Duración de Etapa 

Punto Fijo de Temperatura 

Punto Fijo de Alarma – Temperatura Alta 

Punto Fijo de Alarma – Temperatura Baja 

Punto Fijo de Humedad 

Punto Fijo de Alarma – Humedad Alta 

Punto Fijo de Alarma – Humedad Baja 

Punto Fijo CO₂  

Punto Fijo de Alarma - CO₂ Alto 

Punto Fijo de Alarma - CO₂ Bajo 

Punto Fijo Damper manual 

Punto Fijo Damper Mínimo 

Modo de Control del Damper ** (próx. página) 

Tiempo de Volteo – Inclinado 

Tiempo de Volteo – Nivel 

Punto Fijo Activación Ventilador Aux.Damper 

Modo Ventilador Auxiliar ** (próxima página) 

Modo Enfriamiento ** (próxima página) 

Edo.Velocidad Ventilador: 0=Auto;1=Manual 

Velocidad Ventilador en Manual 

Sentido del Ventilador:  0=Auto    1=Manual 

Dos Sentidos: 0=Adelante;1= Sentido Contrario 

Tiempo en Minutos – Adelante  

Tiempo en Minutos – Sentido Contrario 

Programación por Etapas (continuación) 

Disponible Únicamente con el Maestro 
 

 
Los íconos a la izquierda son variables 
que pueden ser regulados para la 
programación por etapas.    
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 Programación por Etapas (continuación) 

Disponible Únicamente con el Maestro 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

** Damper Control Mode 

4 Manual 

5 Temperature 

6 Humidity 

7 CO2 

 

** Auxiliary Fan Mode 

4 Snowflake On With Cooling 

5 PLC Auto  (Auto Status) 

6 Maintenance (Manual Status) 

7 Off 

 

** Cooling Mode 

6 Water then Air 

7 Water and Air 

8 Air then Water 

9 Air Only 

10 Water Only  

  

** Modo Control del Damper 

      0 Manual 

1 Temperatura 

2 Humedad 

3 CO2 

 

 

 

** Modo Ventilador Auxiliar 

0 Copo de Nieve – Encendido con Enfriamiento 

1 PLC Auto (Estado Automático) 

2 Mantenimiento (Estado Manual) 

3 Apagado 

 

 

 

** Modo Enfriamiento 

1 Agua Después Aire 

2 Agua y Aire 

3 Aire Después Agua 

4 Aire Únicamente 

5 Agua Únicamente 
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Programación por Etapas (continuación)  

Disponible Únicamente con el Maestro 
 
Programación Génesis 3 (10 Etapas): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Programación Génesis 3 (8 Etapas): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

◼ Cuando los programas por etapa tienen menos que 10 etapas, las etapas sin programar 

se mostrarán en gris oscuro y tener un valor de 10. . 
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Programación por Etapas (continuación) 

Disponible Únicamente con el Maestro 

 

Programa por Etapas ULTRA (10 Etapas) 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
◼ Mínimo de Damper: usado únicamente con Pro Set y Pro Hatch.  

 
 
 

Programa por Etapas ULTRA (5 Stages): 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
◼ Como se puede apreciar, cuando se programan menos que 10 etapas, las etapas sin 

programar se ven de color gris y muestran un valor de 0. 

◼ Mínimo de Damper: usado únicamente con Pro Set y Pro Hatch.  

 

Vea la nota abajo 

Vea la nota abajo 

Tipo de Máquina 
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Programación por Etapas (continuación)  
Disponible Únicamente con el Maestro 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

   

◼ Si la máquina y los controles no coinciden, se verá una pantalla de error hasta ser 

corregido. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

◼ Una barra de progreso se desplegará al verificar los controles y máquinas correctas. 
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Programación por Etapas (continuación) 

Disponible Únicamente con el Maestro 

 
 
 
 
 
 
 
 
 
 
 

Botones 
 
 
 
 
 
 
 
 
 
  
 

*  El archivo csv se abre usando Microsoft Excel 
** Usted debe estar seguro que se cargue a la máquina correspondiente, caso     
contrario, recibirá un mensaje de “error”.  
 

 Modificar/Cambiar los Valores 
◼ Siga los pasos a continuación para cambiar el valor de una célula:: 

1. Haga clic en la célula que desea modificar. 

2. Ingrese el número que desea ingresar. 

 

BUTTON USO  

Open Abre un programa de Etapas guardado anteriormente 

Save 
Sobre-escribe el archivo anterior del programa por etapas 

con el programa actual  

Save as 
Guarda el programa actual como un archivo nuevo de 

etapas. 

Export Exporta el programa actual con un archivo. csv* 

Upload Se carga el programa por etapas de la máquina.** 

Send Envía el programa actual de etapas a la máquina.  

Directorio: el sitio donde está guardado 

el archivo del programa 

Para configurar la cantidad de etapas.  

Tipo de máquina 

Una lista de las máquinas cargadas 
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Control de Etapas  
Disponible Únicamente con el Maestro 
 
El control de etapas es usado para manejar las etapas configuradas para las máquinas. Si el 
programa por etapas ha sido activado, el control estará en modo “Go”. Si una etapa debe estar 
detenida, se debe tocar el modo “Stop”. En este momento la máquina mantendrá la última 
configuración hasta que se tomen medidas adicionales. Si una etapa debe estar atrasada o 
adelantada, el botón de “Change” se debe usar para producir el ambiente deseado para los 
huevos fértiles y pollitos dentro de los parámetros de la planta de incubación.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

El nombre de la 

máquina se ve en 

este cuadro. 
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Configurando una Unidad CC3 
Disponible Únicamente con el Maestro 
 
 
Para añadir el CC3 a la Red, usted necesita: 
 

1. Acceso al Modo “Edit” del Maestro 

2. Un plano de los sensores del edificio (provisto por Chick Master) 

 
En la reseña de la Planta de Incubación, haga doble clic en la sala en que desea añadir 
los detalles de la sala CC3. En el ejemplo a continuación, añadiremos 2 Plenums y datos 
de Sala.  
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Ejemplo del Plano de Sensores:  
Disponible Unicamente con el sistema Maestro 
 

Note un plenum para la sala de incubadoras y dos salas separadas de nacedoras, cada 

una con el sensor del presión del plenum mostrado en los círculos.        Los controles del 

plenum pueden ser controladas utilizando un damper motorizado como ilustrados en los 

óvalos.           Existen tres sensores de temperatura y humedad, uno para la sala de 

incubadoras y uno en cada una de las tres salas de nacedoras, identificados con los 

rombos.     La presión individual de las salas, para cada una de las tres áreas se ven con 

los rectángulos.      Los triángulos indican los ventiladores de extracción. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

 
 
 
 
 
 
 

EF1 

EF2 EF3 

EF =   EXHAUST FAN 
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Configurando una Unidad CC3 
Disponible Únicamente con el Maestro 

 
 
 
 
 
Con la Vista de la Sala, haga 
un clic con la derecha donde 
va a añadir el primer plenum y 
seleccione la Opción de 
Controlador de Sala para el 
“Plenum CC3”. 
 
 

 

 

 

 

 

 

 

 

 
 

 
 
 
Seleccione el área donde 
desea representar el primer  
Plenum. 
 
Ingrese aquí los detalles del 
puerto de comunicaciones y 
la ID del nodo, como 
también el nombre del 
plenum. (opcional) Ponga el 
plenum “Online” para 
habilitar la recuperación de 
datos.  
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Configurando una Unidad CC3 (Continuado) 
Disponible Únicamente con el Maestro 
 
 
 
 
 
 
 
 
 
Haga clic en 
“File> Save” para 
guardar los 
cambios. En 
“Save”, la opción 
para seleccionar 
los elementos del 
sensor estarán 
desbloqueada.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ahora haga clic 
con la derecha 
sobre el Plenum, 
y vaya a 
propiedades 
(“Properties”). 
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Configurando una Unidad CC3 (Continuado) 
Disponible Únicamente con el Maestro 
 
Ahora con la opción “Elements…” disponible, haga clic y seleccione los sensores 
dedicados al plenum, según el plano provisto por Chick Master de los sensores en el 
edificio.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Seleccione los sensores de la lista desplegable que corresponden a los sensores en el 
plano.  

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

 
 
Al finalizar, haga clic en “ok” en ambos recuadros 
y guarde los cambios en el menú “File>Save”.  
 
 
Repita estos pasos para el Plenum 2. 
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Configurando una Unidad CC3 (Continuado) 
Disponible Únicamente con el Maestro 
 
Los pasos para agregar los detalles de la sala son muy similares. Haga clic con la 
derecha y seleccione “New Room Controller>CC3 Room”. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Dibuje la sala en el espacio entre las 
incubadoras. Se debe ingresar el 
nombre de la sala, las 
configuraciones del puerto de 
comunicación y las direcciones, y 
online/offline. Seleccione “Online” 
para permitir la recuperación de 
datos.  
 

 

 

 

 

Haga clic en “Ok” y guarde los 
cambios. Esto permitirá acceso a 
la sección de “Elements…”   
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Configurando una Unidad CC3 (Continuado) 
Disponible Únicamente con el Maestro 

 

 

 

 

 

 

Con los cambios 
guardados, haga clic 
con la derecha y vaya 
a “Properties”.  
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Seleccione el botón       
“Elements…”  
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Configurando una Unidad CC3 (Continuado) 
Disponible Únicamente con el Maestro 
 

Muy similar al plenum, usted tendrá una serie de ventanas desplegables para cada uno 
de los sensores. Usando el plano de los sensores del edificio como guía, seleccione los 
sensores correspondientes, dejando configurados “unused” (sin usar) los componentes 
que no son disponibles en esta sala.   En el caso de los Plenums 1 y 2, use las mismas 
configuraciones que se usaron para los plenums anteriores para las selecciones. La sala 
mostrará todos los sensores a la vez, mientras los plenums muestran únicamente los 
datos del plenum específico. 
 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Sala 1 de Incubadoras 

Sala 1 de Incubadoras 
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Configurando una Unidad CC3 (Continuado) 
Disponible Únicamente con el Maestro 
 
Al finalizar con la selección de sensores, haga clic en “ok”, y antes de salir del recuadro 
de propiedades, configure la potencia de cada una de los servicios. Este paso es 
opcional, sin embargo necesario si se usa un estimador de uso. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Con la configuración finalizada, guarde 
sus cambios por medio del menú  
 “File>Save”. 
 

 
 
 
 

 
 

  

Sala 1 de incubadoras 
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Step-by-step Instructions to Update Maestro Software 
 

Siga estas instrucciones paso a paso para actualizar su software actual de Maestro. 
 
Usted puede bajar el programa a una memoria USB e instalarlo en el PC del Maestro; o si 
usted tiene acceso a internet en el PC del Maestro, siga las instrucciones abajo desde 
aquel PC.  
Antes de cargar la versión nueva del software Maestro, salga de la versión actual. 
 
Siga los pasos a continuación para guardar una copia de la versión actual. Diríjase a:  

C:\ChickMaster 
 
Seleccione el directorio “CMaestro” y con el cursor sobre el mismo, haga un clic con la 
derecha. Se abrirá un menú desplegable. Siga hasta “Send to” Se abrirá otro menú 
desplegable. Haga clic en  “Compressed (zipped) folder”. 
 
 
 

Ponga un nombre a la carpeta 
nueva y guárdela. El nombre de la 
carpeta debe ser fácil de identificar 
para uso futuro. Recomendamos 
usar la fecha como identificación al 
guardarla, pues en el futuro será 
útil. Es muy probable que el 
personal de la planta de incubación 
tenga que buscar datos de 
diferentes períodos de tiempo para 
hacer comparaciones. Al guardar 
estos archivos, usted podrá 
descomprimir y re-crear su copia 

del Maestro, la versión exácta, el plano de la planta y los datos según cuando fue 
comprimido. Con el tiempo, usted tendrá múltiples copias comprimidas, las cuales se 
podrán restaurar al período de tiempo que encuadran con la producción actual. 
 
Su carpeta se verá así después de comprimir una copia que hayas nombrado. En este 
caso es “CMaestro Saved April-9-2015”. 
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Instrucciones Paso a Paso Para Actualizar el Software  
 

Para comenzar, use este enlace para abrir la página del sitio web de Chick Master: 
 

http://www.chickmaster.com 
 

En la esquina superior derecha, haga clic en “Spanish”. En la página de inicio, y haga 
clic en “Control”.  Desplácese hacia abajo hasta llegar a “Manejo Integrado de la Planta 
de Incubación.” Nuevamente, desplácese hacia abajo, y llegará a “Mantenga a su 
Maestro o Sistema Advisor actualizado”. Haga clic en el texto “clic aquí”, y complete los 
datos requeridos en la siguiente página. Haga clic en “enviar”, y se abrirá una página 
para descargar la versión más actualizada de Maestro (v20XX.XX.XX).  

 
 
 

Presione “Download 
Maestro v20XX.XX.XX”. La 
fecha actual de la versión 
estará en lugar de  

“20XX.XX.XX”.  

 
 
 
 
 
 
 
 
 

 
Guarde la versión nueva.  
(Ahora usted puede guardar el archivo en una memoria USB para bajarlo en el PC del 
Maestro para copiarlo en el disco duro si no está conectado directamente a internet) 
 
Con el archivo descargado en el disco duro 
del PC del Maestro, presione el archivo de la 
versión nueva. 
 
En el Explorador de Internet, el archivo está 
en la carpeta de “Downloads”. Aparecerá una 
caja de diálogo que permite ejecutar el 
programa. Usted lo puede encontrar luego en 
“Tools\View Downloads”. 
 
 
 
 
 

 

http://www.chickmaster.com/
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Instrucciones Paso a Paso Para Actualizar el Software  
(continuación) 

 

La siguiente ventana será el Explorador de Windows. Haga un doble clic en la aplicación 
“CMaestro Installer v201X.XX.XX”. Seleccione “Run”. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
La caja de diálogo de la configuración (Setup) sigue. 
 
Verifique que la versión actual esté apagada antes de continuar. Usted debe salir de la 
misma. 
 
Seleccione  “Next”: 
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                          Presione aquí antes de tocar “Finish”! 
 

Instrucciones Paso a Paso Para Actualizar el Software  
(continuación) 

 
Seleccione “Install”: 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Usted está actualizando una versión existente.  
La próxima pantalla de diálogo será “Completing the CMaestro Setup Wizard”.  
Seleccione “Run CMaestro” para ejecutar el programa. 
 
*** Es importante  seleccionar “Upgrade from Previous Installation…” para guardar el 
plano de su planta de incubación y los datos de las máquinas; caso contrario, esta 
información no estará incluida en la actualización: 

 
 
 
 
 
 
 
 
 
. 
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Instrucciones Paso a Paso Para Actualizar el Software  
(continuación) 

 
 
 
Seleccione “Yes” para continuar. 

 
 
 
 
 
 
 
Haga clic en “OK”. 

 
 
 
 
 
 
 
Haga clic en “Finish”: 

 
 
 
 
 
 
 
 
 
 
Cuando el Maestro aparece en la pantalla, será la misma versión mostrada en el enlace 
para bajarla.  
 

 
 
 
La nueva versión “20XX.XX.XX” 
será visible en la barra superior 
a la izquierda de Maestro 
cuando esté funcionando en el 
PC. 
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No seleccione 

Re-Instalar el Software Maestro  

 
1. Apagar el sistema Maestro. 

2. Por medio de Windows Explorer, navigue a C:\ChickMaster directory 

3. Haz un clic con la derecha en la carpeta CMaestro para crear una copia de respaldo. 

4. Seleccione “Send to” y “Compressed (zipped) folder.” 

5.  Traslade la carpeta de CMaestro, el archivo de la licencia “cmhn.lic” desde el 

directorio CMaestro y “header.dta” desde el directorio de Data a una carpeta segura, 

fuera del directorio ChickMaster. 

 

 

 

6. Borre el directorio ChickMaster. 

7. Vaya a 

http://www.wolfcreekmicro.com/maestro.htm 

 y descargue la última versión de Maestro.  

8. Al instalarla, no elijas “Upgrade  

from Previous Installation.”  

9. Deseleccione la opción “Run CMaestro”. 

10. Seleccione “Finish” 

11. Antes de ejecutar el Maestro, coloque “cmhn.lic” en en directorio nuevo, CMaestro. 

 

12. Antes de ejecutarlo, coloque 

“header.dta” en el nuevo directorio de 

data.  
 

 

 

 

 

 

 

 

 

13. Ejecute Maestro. Si todo ha sido 

hecho correctamente, Maestro debe 

arrancar mostrando todas las 

máquinas y los componentes de la 

planta de incubación. Si existe un 

problema, vuelva al estado original por medio de la copia de respaldo.                                              

 

http://www.wolfcreekmicro.com/maestro.htm
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        ELECTRICAL DRAWINGS INCLUDED AT END OF MANUAL. 

 

 

 

 

DIBUJOS ELÉCTRICOS INCLUIDOS AL FINAL DEL MANUAL. 
 

 


